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ABSTRACT

In this era of globalization, technology is one of the best initiatives to improve the quality of
agricultural-based products. The Government of Malaysia suggests that agriculture can be
implemented in residential areas without requiring large spaces. However, there are
challenges in managing aquaculture and hydroponic systems, particularly in water filtration.
Existing systems rely on non-renewable power sources, contributing to environmental
issues, and lack advanced monitoring tools for real-time water quality checks. These
limitations result in inefficiency, increased costs, environmental harm, and maintenance
difficulties. Furthermore, the absence of continuous monitoring prevents these systems from
adapting to changing water conditions, risking poor filtration performance and water quality.
The objective of this project is to develop hardware for a water filtration system powered by
solar energy with an IoT-based monitoring system, to develop software to control, optimize
and monitor the operation of the water filtration system, to evaluate the performance of the
water filtration system. This filtration system used Esp8266 as a microcontroller to control
input and output of the system and Real-Time Firebase as a transmitter to transfer data to
mobile application, respectively. Sensor used to detect water condition in fishpond. All of
the system powered by solar as a supply include microcontroler and dc water pump.
Observation for 4 days in every mode have been made for an automated water filtration
system and normal system. It show that energy used based on automated water filtration
which is mode 4 more saving compared to normal system in mode 1. This project is easy to
used and user-friendly as it improve power consumption while powerd by solar of this water

filtration system.



ABSTRAK

Dalam era globalisasi ini, teknologi merupakan salah satu inisiatif terbaik untuk
meningkatkan kualiti produk berasaskan pertanian. Kerajaan Malaysia mencadangkan
bahawa pertanian boleh dilaksanakan di kawasan perumahan tanpa memerlukan ruang yang
besar. Namun, terdapat cabaran dalam menguruskan sistem akuakultur dan hidroponik,
terutamanya dalam penapisan air. Sistem sedia ada bergantung kepada sumber tenaga tidak
boleh diperbaharui, yang menyumbang kepada isu alam sekitar, serta kekurangan alat
pemantauan canggih untuk pemeriksaan kualiti air secara masa nyata. Kelemahan ini
menyebabkan ketidakcekapan, peningkatan kos, kesan negatif terhadap alam sekitar, dan
kesukaran dalam penyelenggaraan. Selain itu, ketiadaan pemantauan berterusan menghalang
sistem ini daripada menyesuaikan diri dengan perubahan keadaan air, sekali gus berisiko
menyebabkan prestasi penapisan dan kualiti air yang rendah. Objektif projek ini adalah
untuk membangunkan perkakasan bagi sistem penapisan air yang menggunakan tenaga solar
serta sistem pemantauan berasaskan loT, membangunkan perisian untuk mengawal,
mengoptimumkan dan memantau operasi sistem penapisan air, serta menilai prestasi sistem
penapisan tersebut. Sistem penapisan ini menggunakan ESP8266 sebagai mikropengawal
untuk mengawal input dan output sistem serta Firebase Realtime sebagai pemancar untuk
menghantar data ke aplikasi mudah alih. Sensor digunakan untuk mengesan keadaan air di
dalam kolam ikan. Keseluruhan sistem ini dikuasakan oleh tenaga solar, termasuk
mikropengawal dan pam air DC. Pemerhatian selama empat hari telah dilakukan bagi setiap
mod untuk sistem penapisan air automatik dan sistem biasa. Hasil kajian menunjukkan
bahawa penggunaan tenaga dalam sistem penapisan air automatik (Mod 4) adalah lebih
menjimatkan berbanding sistem biasa dalam Mod 1. Projek ini mudah digunakan dan mesra
pengguna kerana ia meningkatkan kecekapan penggunaan tenaga, terutama apabila

dikuasakan sepenuhnya oleh tenaga solar.
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CHAPTER 1

INTRODUCTION

1.1 Project Background

Water filtration systems used in fish farming traditionally depend on conventional
power sources, which are predominantly non-renewable and contribute significantly to
environmental challenges. These systems are often rudimentary in design, relying on
outdated technologies or manual processes that lack precision and fail to account for the
dynamic nature of aquatic environments. This inefficiency often results in poor water quality
management, which directly affects fish health, productivity, and the overall sustainability
of fish farming operations. Furthermore, the reliance on non-renewable energy sources, such
as fossil fuels, exacerbates environmental degradation while driving up operational costs,
making such systems less viable in the long run.

One major limitation of traditional water filtration systems is their inability to
continuously monitor and respond to changes in water quality parameters such as
temperature, dissolved oxygen, or total dissolved solids (TDS). Inconsistent monitoring
means that water quality can deteriorate rapidly without timely intervention, leading to
conditions that are detrimental to aquatic life. For instance, high levels of ammonia or
inadequate oxygenation can stress fish, reducing their growth rates and increasing mortality.
This lack of adaptability and real-time oversight not only compromises the health of the
aquatic ecosystem but also poses a risk to the livelihoods of fish farmers who depend on

steady yields.



In addition to these technical shortcomings, the energy-intensive nature of
traditional filtration systems often adds a significant financial burden to fish farming
operations. Pumps, aerators, and other equipment operate continuously, regardless of actual
need, leading to energy wastage and increased wear and tear. Frequent maintenance and
repairs further inflate costs, while unscheduled downtime can disrupt operations and
negatively impact fish survival rates. This inefficiency underscores the pressing need for
systems that are both cost-effective and environmentally sustainable.

The broader environmental implications of traditional systems are also a cause for
concern. The dependence on fossil fuels contributes to greenhouse gas emissions,
accelerating climate change. Moreover, inefficient water management practices can lead to
pollution in surrounding water bodies, harming local ecosystems and reducing biodiversity.
As the global demand for fish continues to rise, these issues highlight the unsustainable
nature of conventional fish farming practices and the urgent need for innovative solutions
that address both environmental and operational challenges.

In recent years, technological advancements have opened new possibilities for
addressing these longstanding challenges. The integration of advanced monitoring systems,
energy-efficient components, and automated controls into water filtration setups has the
potential to revolutionize aquaculture. These technologies aim to optimize water quality
management while minimizing energy consumption and environmental impact. For
example, sensors capable of measuring critical water parameters can provide continuous
data, enabling fish farmers to identify and address potential issues before they escalate.
However, the adoption of such technologies is not without its challenges, particularly for
small-scale farmers who may lack the technical knowledge or financial resources to

implement and maintain these systems.



Another promising development in water filtration is the use of wireless
communication technologies, which enable remote monitoring and control. Devices
equipped with Wi-Fi or similar connectivity options can transmit real-time data to
centralized systems, reducing the need for on-site management. This can be particularly
beneficial in large-scale or remote fish farming operations, where manual oversight is often
impractical. By enabling seamless communication between various system components,
wireless technologies can help streamline operations and improve overall efficiency.

Cloud computing further enhances the potential of modern water filtration systems
by providing a platform for storing and analyzing data. Historical data on water quality
trends, energy usage, and system performance can be invaluable for making informed
decisions about maintenance schedules, resource allocation, and operational adjustments.
However, the integration of cloud-based solutions also raises questions about data security,
accessibility, and the need for reliable internet connectivity, which may be limited in rural
or underdeveloped areas.

Sustainability is another critical consideration in the evolution of water filtration
systems. The incorporation of renewable energy sources, such as solar or wind power, offers
a pathway to reducing reliance on non-renewable resources. Solar-powered pumps and
sensors, for example, can operate independently of the grid, making them ideal for off-grid
or resource-constrained settings. By combining renewable energy with smart technologies,
these systems can achieve greater energy efficiency, reducing both costs and environmental
impact. However, the upfront investment required for renewable energy infrastructure

remains a barrier to widespread adoption.



In addition to environmental benefits, the development of user-friendly interfaces
has been instrumental in making advanced technologies more accessible. Mobile
applications, for instance, allow fish farmers to monitor and control their systems remotely,
receiving alerts and updates in real time. This democratization of technology ensures that
even those without a technical background can leverage modern tools to improve their
operations. Nevertheless, the effective use of such interfaces depends on adequate training
and support, highlighting the need for capacity-building initiatives alongside technological
innovation.

Overall, the challenges faced by traditional water filtration systems underscore the
importance of transitioning to smarter, more sustainable solutions. By addressing
inefficiencies in energy use, water quality management, and operational oversight, modern
technologies have the potential to transform aquaculture practices. However, the successful
implementation of these innovations requires careful consideration of factors such as cost,
accessibility, and user education to ensure that they meet the diverse needs of fish farmers

around the world.



1.2 Problem Statement

One big issue in fishpond management is the high energy use of traditional filtration
systems that run all the time, even when the water is clean. This wastes energy, raises costs,
and harms the environment. To fix this, I suggest using a smart filtration system that only
turns on when the water gets turbid. This system uses [oT technology and solar power to
monitor water quality in real-time and manage filtration efficiently. This solution can save
power, reduce costs, and lower the carbon footprint of fishpond operations. It supports SDG
6: Clean Water and Sanitation by keeping water quality high, and SDG 7: Affordable and
Clean Energy by using less energy and promoting renewable sources. This benefits fishpond
owners, environmentalists, and communities that depend on aquaculture. It also follows
regulations for energy conservation and environmental protection, helping to fight climate

change and promote sustainable fishpond management.

1.3 Project Objective

The project objectives are follows :
a) To develop hardware for a water filtration system powered by solar energy
with an IoT-based monitoring system.
b) To develop algorithm to control, optimize and monitor the operation of the
water filtration system.

c) To evaluate the performance of optimization in the water filtration system.



1.4 Scope of Project

The fishpond water filter system project, combined with an IoT-based controller,
covers various aspects of hardware and software development, renewable energy use, and
aquatic management. Here's a breakdown of what the project includes:

a) Hardware Development

The hardware development for this project involves several critical components
designed to ensure optimal functionality and sustainability of the fishpond filtration system.
The process begins with designing the fishpond to support efficient water circulation and
filtration. Selecting the appropriate water pump is essential, as it must deliver adequate flow
rates while consuming minimal energy. To power the system sustainably, solar panels are
integrated to supply renewable energy, making the system ideal for off-grid locations. The
filtration system incorporates both biological and mechanical methods to maintain water
quality. Biological filtration uses beneficial bacteria to break down harmful compounds,
while mechanical filtration removes debris and solid particles. Additionally, sensors are
embedded to monitor key parameters such as temperature, dissolved oxygen, and TDS
levels. The ESP8266 microcontroller is chosen as the central control unit for its IoT
capabilities and Wi-Fi connectivity, enabling real-time communication and system

automation.



b) Software Development

The software development aspect of the project ensures seamless integration
between hardware components and user interfaces. Sensors collect real-time data on water
quality, which is processed and transmitted by the ESP8266 microcontroller. IoT-based
control allows for automated decision-making, such as adjusting pump operations based on
TDS levels or activating aerators when dissolved oxygen drops. A custom Android
application, developed using MIT App Inventor, provides a user-friendly interface for
monitoring and controlling the system. The app displays real-time sensor data, sends alerts
for abnormal conditions, and allows manual control of pumps and other devices. Firebase
serves as the cloud platform, storing data securely and enabling remote access. This
integration ensures that users can monitor their fishponds from anywhere, improving
efficiency and reducing the need for constant on-site supervision.

¢) Solar Energy Integration

The use of solar energy in this project is a pivotal feature, making the fishpond
filtration system highly sustainable and suitable for remote locations. Solar panels convert
sunlight into electrical energy, which powers the pumps, sensors, and control units. By
utilizing renewable energy, the system reduces its carbon footprint and minimizes
dependence on grid electricity. Advanced battery storage solutions ensure continuous
operation even during periods of low sunlight. The integration of solar power also lowers
operational costs, making the system economically viable for small-scale and large-scale
fish farmers alike. Combining solar energy with IoT technology enables intelligent energy

management, where devices operate only when needed, further enhancing efficiency.



d) Testing and Deployment

The project will undergo rigorous testing to ensure reliability and effectiveness.
Each hardware component, including the water pump, sensors, and ESP8266, will be
individually tested for performance and accuracy. Software functionalities, such as real-time
data transmission and app interface responsiveness, will also be thoroughly evaluated.
Simulated scenarios will test the system’s ability to respond to varying water quality
conditions, ensuring that automated controls function as intended. Comprehensive
documentation will accompany the development process, detailing system design,
configuration, and troubleshooting steps. Strategic deployment will involve setting up the
system in real-world fishpond environments, monitoring performance over time, and
gathering feedback for further refinement. The ultimate goal is to implement a robust
fishpond filtration and IoT monitoring system that enhances -efficiency, reduces
environmental impact, and provides users with a reliable, easy-to-use solution.

In conclusion, the integration of IoT, cloud computing, Wi-Fi connectivity, and
user-friendly platforms like Firebase and MIT App Inventor into water filtration systems
represents a significant leap forward. It addresses the inefficiencies and environmental
concerns of traditional setups while empowering fish farmers with advanced tools for real-
time monitoring and control. This holistic approach ensures that water filtration systems are
not only sustainable but also scalable, paving the way for a smarter and greener future in

aquaculture.



CHAPTER 2

LITERATURE REVIEW

2.1 Introduction

The rapid development of the Internet of Things (IoT) has transformed many
industries by allowing devices to communicate and perform tasks independently. As the
number of IoT devices grows, effective power management becomes increasingly important.
Power optimization in IoT systems is a major global concern, particularly for increasing
device life and ensuring sustainability. This is especially important in remote areas where
frequent battery replacement is impractical. Current strategies are centered on utilizing
renewable energy sources such as solar and kinetic energy, increasing battery storage
capacity, and implementing low-power hardware and efficient communication techniques.
Despite these advances, scaling these solutions and seamlessly integrating multiple devices
remains difficult, focusing on the need for continued innovation and development.

Microcontrollers are important components in IoT applications, providing a wide
range of capabilities from basic control to complex data processing and connectivity. Popular
choices include the ESP8266 and ESP32, which are valued for their low cost and built-in
Wi-Fi capabilities, making them suitable for a wide range of IoT applications. The Raspberry
Pi, Arduino Uno, STM32, and ATtiny85 are also popular, with each offering distinct features
such as processing speeds, memory capacities, and connectivity options. These
microcontrollers are essential for creating prototypes and finished products, as they enable

efficient data collection, processing, and communication in IoT systems.



In terms of renewable energy, solar power has emerged as an important factor in
meeting the energy demands of 1oT systems, particularly in off-grid and remote areas. Solar
photovoltaic (PV) systems are a sustainable and cost-effective way to generate electricity,
helping to conserve the environment and ensure energy security. Effective energy storage
solutions, such as lithium-ion batteries, help solar power systems by providing a consistent
power supply. Integrating IoT technology with solar energy systems improves their
functionality by allowing for real-time monitoring and optimization of power usage. This
integration is essential for developing flexible and efficient IoT systems that can operate
autonomously and sustainably, establishing the way for progress in a variety of industries,

including agriculture, environmental monitoring, and smart cities.

2.2 Understanding Current Issue in the Literature

Power optimization in IoT systems is a significant global issue because the number
of IoT devices is growing rapidly, making efficient energy use crucial for longer device life
and sustainability. This is especially important in remote areas where changing batteries
often isn't possible. Current trends focus on using energy from sources like solar and kinetic
energy and improving batteries to store more energy. Strategies to reduce power use include
using low-power hardware, efficient communication methods, cycling devices between
active and sleep states, and processing data close to where it's collected to save energy.
However, challenges like making these strategies work on a large scale, ensuring different
devices can work together, and using Al to manage power use dynamically still need to be
solved. Addressing these challenges is key to the sustainable and efficient use of IoT systems

worldwide[1].
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2.3 Internet of Things (IoT)

The Internet of Things (IoT) is a system where different devices or objects can
communicate over the internet without human input. It's used in many ways to make life
easier. When making IoT products, the first step is to create prototypes. These prototypes
include things like screens for users, hardware like sensors and processors, software for the
server-side, and ways to connect everything together. We often use small computers called
microcontroller units (MCUs) or development boards for these prototypes. One popular
choice is the ESP8266 wifi chip, which is supported by platforms like NodeMCU and
Espruino. The ESP8266 is known for being affordable and powerful, making it great for [oT
projects that need to connect to networks or the internet. Studies have shown that it's widely
used and effective for these purposes[2].

The ESP8266EX (Figure 2.1), officially known as ESP8266, is a chip that can
connect to Wi-Fi and has a processor called Cadence Tensilica L106 32-bit RISC. It also has
memory control features like SRAM and ROM built-in [3]. People like to use the ESP8266
chip in data gathering systems because it's cheap, uses little power, and is good at processing
information. Plus, it has useful features like built-in Wi-Fi, lots of input/output ports, and is
easy to program. They use an open-source platform called ThingSpeak to store and show the
data in graphs and dashboards. This keeps the system affordable and easy for anyone to

use[4].
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Figure 2.1 Esp8266 module

The ESP32 in Figure 2.2 is a type of microcontroller made by Espressif Systems,
following on from their earlier ESP8266 model. It's designed to work with the Arduino
programming environment. This microcontroller comes with built-in Wi-Fi and connects to
Bluetooth Low Energy (BLE) using a separate chip. Because of this, it's very powerful and
a great choice for making IoT applications. The name "ESP32" comes from "Espressif32,"
and it's a development board made by Espressif Systems. The ESP32 has a 32-bit processor
and supports wireless networking through Wi-Fi and Bluetooth Low Energy (BLE) using

the 802.11 b/g/n Wi-Fi protocol at 2.4 GHz, along with Bluetooth v4.2 technology[5].

Figure 2.2 Esp32 Module
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2.4 Microcontroller For 1oT Applications

A microcontroller is a tiny and affordable computer that's made to do particular jobs
in embedded systems, such as showing info on a microwave or getting signals from a remote.
Usually, it includes a processor, memory (like RAM, ROM, and EPROM), serial ports, and
extras like timers and counters. These are made for specific tasks in different kinds of

machines[6]. Figure 2.3 show programme inside the microcontroller.

Figure 2.3 Example of Universal Microcontroller

In mechatronics, computers are used to create programs for devices like
microcontroller-based programmable controllers, which are also known as programmable
logic controllers (PLCs). When we pair sensors with these controllers to get input
information and devices controlled by the controller (called 'actuators'), we form a simple
mechatronic system. The program, typically made on a computer, is then transferred to the

programmable controller[7].
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2.4.1 Rasberry Pi Module

The Raspberry Pi in Figure 2.4 is a small and powerful mini-computer, roughly the
size of a credit or debit card. It was created by the Raspberry Pi Foundation in the United
Kingdom with the goal of inspiring and empowering learners to be more creative and
effective. Unlike many video games, the Raspberry Pi is a versatile microcontroller that's
not very expensive. With it, users can learn programming, including Python coding, build
robots, and work on various creative projects. It can do all the things a regular computer can

do, like browsing the internet, watching movies, playing games, and listening to music[8].

Figure 2.4 Respberry pi module
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2.4.2 Arduino Uno Module

The Arduino microcontroller is an open-source tool that's easy to program and can
be updated whenever needed. It was first introduced in 2005. Originally, Arduino was made
for professionals and students to create devices that interact with their surroundings using
sensors. The Arduino platform has two main parts: hardware and software. The hardware
includes the Arduino development board, while the software used for coding is called the
Arduino IDE (Integrated Development Environment). It's powered by 8-bit Atmel AVR
microcontrollers made by Atmel, or 32-bit Atmel ARM microcontrollers. These
microcontrollers can be programmed using the C or C++ language in the Arduino IDE [9].

Figure 2.5 show example Arduino microcontroller.

Figure 2.5 Arduino uno module
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2.4.3 STM32 Module

The STM32 series in Figure 2.6 uses the ARM Cortex-M3 core, which is made for
embedded applications needing good performance, affordability, and low power usage[10].
These microcontrollers are built on the ARM Cortex-M3 architecture. They bring together
strong performance, real-time capabilities, digital signal processing, low power usage, and
the ability to work on low voltages. In this IoT module, the specific microcontroller used is
the STM32F103VET6, which is positioned as a mid-level chip within the STM32 series[11].
The STM32F446RE microcontroller, chosen by students to learn microcontroller
programming, is a high-performance chip made by STMicroelectronics. It features an Arm
Cortex-M4 core built specifically for digital signal processing tasks. This microcontroller
was picked for the educational program because of its strong performance, DSP instruction

set, and multiple ADC functions, allowing for faster AD conversion[12].

Figure 2.6 STM32 module
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2.4.4 Attiny Microchip

The ATtiny85 is an 8-bit microcontroller designed for low power usage and
constructed using CMOS logic. It follows the AVR enhanced RISC architecture and can
perform approximately 1 million instructions per second. Despite its low power
consumption, it operates at a high speed. The ATtiny85 offers 8K bytes of flash memory,
EEPROM ranging from 128 to 512 bytes, 256 bytes of SRAM, six GPIO lines, 32 general-
purpose registers, an 8-bit timer/counter with compare modes, both External and Internal
Interrupts, a high-speed 8-bit timer, a 10-bit ADC, a watchdog timer with an internal clock
oscillator, and three power-saving modes. It is compatible with the Arduino IDE
environment, making it easy to work with[13]. Figure 2.7 show example of Attiny

microchip.

Figure 2.7 ATtiny microchip
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2.4.5 Summaries of Microcontroller

Microcontrollers come in different prices and features. Cheaper ones are good for
simple projects, while more expensive ones can handle more complex tasks. Some have
built-in Wi -Fi and Bluetooth, making them great for smart home and IoT projects. Their
processing speeds range from slow to very fast, depending on what you need. They have
different numbers of input/output pins, which affects how many other devices you can
connect. Power usage varies, with some using very little power and others more. Memory
size also differs, assessing their data handling capacity. Some are easy to use with lots of
online help, while others need more technical know-how. They can be used for anything
from basic hobby projects to advanced industrial applications, with various tools available
to help you program and use them. 10T devices are low-cost and energy-efficient. However,
adding more transistors for complex hardware security features could raise the cost of the
SoC and increase power consumption, making them unsuitable for many applications where
thermal design power (TDP) is a concern[14]. Table 2.1 illustrate different between

specification of microcontroller.
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Table 2.1Comparison between specification of microcontroller .

Feature | ESP8266 ESP32 Rasberry pi | Arduino uno STM32 ATtiny85
Tensilica Tensilica Broadoom
Processor | Xtensa | XtensaLX6 | DCM2711 ATmega328P ARM Cortex- AVR
1106 (dual-core) (quad-core M4 ATtiny85
Cortex-A72)
Clock | gommz | 169240 1 y5GH, | 16MHz | 72-120MHz | 1-20 MHz
Speed MHz
520 KB 20-512 KB 512 B
RAM 32 KB SRAM 2-8 GB 2 KB SRAM SRAM SRAM
Flash 4 MB 4 MB microSD
Memory | (external) | (external) card B E 64812885 8 KB
Yes (via Optional
WiFi | Y24 | YeS 245 oiemal No (STM32 Wi-Fi | No
GHz GHz
dongle) module)
. Optional
Yes (via
Bluetooth No Yes, 4.2 and external No (STM32 No
BLE dongle) Bluetooth
& module)
Operating | 5 5y 33V sV sV 33V 2.7-5.5V
Voltage
ADC Varies (via
Resolutio 10-bit 12-bit external 10-bit 12-bit 10-bit
n ADC)
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2.5 Solar System

Solar energy technology has become increasingly important recently. It's being seen
as a viable option for generating electricity in countries like India that need more energy.
Solar power generation helps with environmental issues and makes energy supplies more
secure, while also reducing the carbon emissions produced by coal power plants[15]. This
has several advantages both economically and environmentally. Generating electricity with
solar panels can be cheaper and more sustainable over many years compared to other

methods of generating electricity[16]. Figure 2.8 show example of solar system.

Energy Source Enargy

Inversion & Conditioning

“*“
]u 4

: 4

Energy Storage

Energy Conversion

Figure 2.8 Example connection solar system

2.5.1 Solar Energy

A solar cell is a tool that captures sunlight and turns it into electricity. Sunlight has
energy in tiny particles called photons. When these photons hit a solar cell, they make
electrons move around, creating an electric current. This process is called a photovoltaic
event or photoelectric effect. Solar cells can do this because they're made of a special
material called a semiconductor, which usually contains silicon. This silicon has two layers
that are sensitive to light: a positive layer (P-type) and a negative layer (N-type)[17]. Figure

2.9 show solar panel taht contain solar cell inside.
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Figure 2.9 Solar panel

2.5.2 Energy Storage

Battery storage systems have been created along with power converters, control
programs, and controllers to test how hybrid microgrids work. An energy management
system keeps the power balanced, managing changes in renewable energy generation and
the amount of power needed for different loads[18]. Using energy storage technologies like
DC batteries with a PV system can greatly improve energy use and help the PV system run
smoothly. Lithium-ion batteries (LIBs) have several benefits over lead-acid batteries, like
being able to charge quickly, having high density, lasting a long time, and being smaller and
lighter. This makes them a good choice for short-term energy storage in many situations.
Batteries store electricity made by solar panels that isn't used right away by whatever's using
the power. This stored energy can be used when there's not much sunlight or during the

night[17]. Figure 2.10 show example type battery can used for storage.
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Figure 2.10 Example of battery in energy storage

2.6 Solar Power Optimization

Solar photovoltaic energy is the world's third-largest renewable energy source,
following hydro and wind power. Solar panels directly convert sunlight into electricity. In a
stand alone PV system, it's crucial to maintain a steady power supply to meet energy
demands. One suggested method involves analyzing energy needs hourly and determining
the right sizes for battery banks and PV arrays to meet these needs throughout the day.
Because solar power output changes, the battery storage must be enough to provide
consistent power, no matter how many times the battery is charged or discharged. This
backup ensures a continuous power supply after sunset until solar energy is available again
for recharging[19]. The main goal of organizing this structure is to enhance operational and
economic performance, particularly when dealing with disturbances from intermittent

renewable resources[20].
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2.7 Fishpond Control System

Managing a fishpond includes keeping the water clean, making sure it circulates
well, providing the correct amount of food for fish, controlling how many fish are in the
pond, stopping and treating diseases, taking care of where the fish live, thinking about how
the water moves in and out and gets cleaned, checking on things often, and being careful
about how it affects the environment. These actions all work together to keep the fish healthy
and make sure they can keep living there in a sustainable way. Fish management systems
play a crucial role in aquaculture. One key aspect of fish management is ensuring water
quality, which encompasses factors like temperature, pH levels, oxygen content, and feeding
practices. Currently, the monitoring of water quality and feeding of fish is primarily carried

out manually[21].

2.7.1 Filtering System

Biological water filtration is when harmful substances are taken out of water using
living things. Having the right size biological filter is really important in a system where
water is reused for fish farming. In aquaculture recycling systems, the equipment for
biological water filtration helps make the water from fish ponds safe to use again by getting
rid of bad stuff in it[22]. Figure 2.11 show simple stage in filtration of fishpond. Filtration is
crucial for purifying and decontaminating water and air, both essential for life. Growing
awareness of the connection between air quality and human health has increased the demand
for better personal protection against airborne pollutants and harmful microbes. Electrospun
nanofibres (NFs) offer unique advantages as an active protective layer in facemasks.
Compared to commonly used filters with melt-blown (MB) fibres, electrospun NFs provide

superior protection against airborne particles, bacteria, and viruses[23].
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Figure 2.11 Filtration sample

2.7.2 Water Quality

Understanding water quality can be a complex topic. It's influenced by various
factors, and we use several measurements together to assess it. These measurements include
turbidity, total dissolved solids, and temperature [24]. Aquaculture is gaining importance in
Malaysia as a key driver of economic growth. However, maintaining a healthy environment
for fish production requires careful attention. Water quality plays a crucial role in this,
influenced by factors like dissolved oxygen, ammonia levels, pH, temperature, salt content,
nitrates, carbonates, and more. Typically, fish farmers or researchers manually test these
parameters in fishponds or laboratories to ensure a stable and healthy production

environment [25]. Figure 2.12 sample of water taken to check the quality.

Figure 2.12 Water quality sample
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2.7.3 Household fishpond

A household fishpond is a small-scale aquatic system designed for raising fish at
home, primarily for consumption, recreation, or ornamental purposes. Typically constructed
using materials like concrete, plastic liners, or prefabricated tubs, these ponds require proper
design to ensure adequate water depth, aeration, and filtration. A balanced ecosystem within
the pond, including plants and microorganisms, helps maintain water quality and supports
fish health. Popular fish species for household ponds include tilapia, koi, goldfish, and
catfish, depending on the purpose. Regular maintenance, such as feeding, cleaning, and
monitoring water parameters (e.g., pH, temperature, and dissolved oxygen), is crucial to
keep the pond thriving and the fish healthy. Fishponds can also serve as aesthetic additions

to a home, offering relaxation and promoting sustainable food practices.

2.8 Related Previous Work

To enhance my project, I have reviewed similar projects to understand their
approaches and outcomes. This comparison helps me gain insights into what has worked
well and what can be improved. By summarizing these previous projects, I can identify
strategies and techniques that could be beneficial for my own project. This process allows
me to build upon existing knowledge and make informed decisions to create a more effective

and successful project.
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2.8.1 Project 1 : A Self Monitoring and Analyzing System for Solar Power Station
using IoT and Data Mining Algorithms

Renewable energy sources are receiving significant research attention due to their
economic and sustainable features. Solar power stations, in particular, are seen as viable
renewable energy systems for various locations due to their lower installation and
maintenance costs compared to conventional systems, despite requiring less space. While
small generating stations can be accommodated on open terraces, large-scale power stations
need acres of land, posing a challenge for maintenance. Leveraging [oT and data mining
techniques, the proposed algorithm aims to help human operators detect regular power
generation patterns and identify faults or defective areas in solar power systems swiftly. This
proactive approach enables prompt action for fault rectification, ultimately improving the
efficiency of the generating station[26]. Figure 2.13 show solar connection while measure

voltage, current in this project.

Voltage
( Sensor l
Signal Microcontroller
@ T (;x;rrem Conditioning with loT
nsor :
Circuits module
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—_ ]  ——
Photodiode

Figure 2.13 Solar flow chart
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2.8.2 Project 2 : Development of IoT Based Fish Monitoring System for Aquaculture

This paper discusses the creation of an IoT-based fish monitoring system for
aquaculture, aimed at improving fish production and maintaining water quality. The system
uses [oT devices and an Android app to monitor pH levels, temperature, dissolved oxygen,
and ammonia levels crucial for fish health. Aquaculture is vital for economy but faces
challenges like water pollution and lack of water quality expertise among farmers. This
system offers a cost-effective solution, using sensors and testing kits to provide real-time
data via a user-friendly mobile app. The system's successful implementation demonstrates
its potential to support fish farming sustainability and economic growth[27]. Figure 2.14

show equipment used in the project.

Figure 2.14 Equipment used.
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2.8.3 Project 3 : IoT-Based Smart Aquaponics System Using Arduino Uno

This project suggests an aquaponics system that saves water by circulating it and
using fish waste to produce nutrients for plants in a tank. The system uses sensors, actuators,
and microcontrollers to watch and manage water quality. Sensors collect data transmitted
through Wi-Fi to an IoT cloud platform called Thingspeak, while actuators fix any issues
found by the sensors. The experiments showed that water quality and circulation were good,
as seen in linear regression analysis and R-squared plots that showed a strong link between
time and plant growth and fish weight. This system cuts down on water waste and boosts

aquaponics yields[28]. Figure 2.15 show the hardware develop in the project with full setup.

Figure 2.15 Hardware project.
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2.8.4 Project 4 : Development of Monitoring System Based on Internet of Things

(IoT) for Freshwater Prawn Farming

This project focuses on integrating [oT technology into freshwater prawn farming
to automate water quality monitoring, reduce labor costs, and improve operational
efficiency. By utilizing sensors, microcontrollers, and communication modules, the system
aims to provide real-time data on critical parameters like temperature, pH levels, and
dissolved oxygen. The use of low-cost devices such as Arduino and ESP8266 Wi-Fi modules
enables cost-effective solutions while supporting proactive decision-making for enhanced
productivity and environmental sustainability. Overall, the project aims to contribute to
smart agriculture practices in aquaculture by developing an efficient and tailored loT-based
monitoring system for freshwater prawn farming[29]. Figure 2.16 show full prototype of this

project.

Figure 2.16 Project prototype.
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2.8.5 Project S : Water IoT Monitoring System for Aquaponics Health and Fishery
Applications

This paper outlines the work done to create and test a complete system for
monitoring aquaponics health, focusing on the fishing industry. We found that existing
monitoring systems didn't meet the needs of monitoring the entire aquaponics life cycle. The
new system advances communication technology by using 5G for communication and LoRa
for long-range communication between nodes and gateways, with LTE-M/NB-IoT for
internet connectivity. For aquaculture, we've improved the sensing layer with more sensors
to enhance performance in the fishing industry. The sensing and compensation processes
take between 0.9 s to 1.5 s for digital sensors and 0.3 s for analog ones, with the whole
sensing period averaging around 7.5 s with nine sensors. Information packets take about 463
ms to reach the CORE from the sensing node. We've also redesigned the hardware
architecture to improve energy efficiency and reduce power consumption, extending battery

life by around 70% with the inclusion of a switching IC for sensors connected to the 12C

line[30]. Figure 2.17 show aquaponics cycles in this report.
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Figure 2.17 Aquaponics cycle
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2.9 Summary

Table 2.2 and Table 2.3 show comparing different projects shows how they use
software and hardware in various ways. Some projects use simple sensors and manual
controls, while others have advanced features and better connectivity. Projects with Wi-Fi
capabilities are good for IoT applications, and those with solar power systems are more
energy-efficient. Using strong IoT integration helps with better remote control and
monitoring, while advanced features handle complex tasks well. Solar-powered projects are
more sustainable and cost-effective in the long run. These insights can help choose the best
components to balance connectivity, functionality, and energy efficiency for better project

results.
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Table 2.2 This table show comparison between related previous project.

Tot

Cloude

Previous project Microcontroller Based Solar energy IoT
Project 1, 2021 Yes: Utilized solar i“mfﬁzfﬁoﬁfver
J ’ GSM module 6LoWPAN | energy for powering the | . .
By Shakya S wide areas using
system. 6LoWPAN
g{gle C]t32’,19a i:loi];lfr Yes: Leveraged
ol No: Did not incorporate | ESP8266 for IoT,
ABegum . . .
MIT and solar energy, making allowing real-time data
HShachcho L :
Esp8266 Google the system dependent communication with
SKhan MY eboah- } s .
X ] Firebaase on traditional power Firebase and seamless
© sources app integration via
BMasud MAI- ' v o
AmriJ ’
Project 3, October No: Absence of solar
2021. By Ntulo . . .
. 4 . energy integration Yes: Used Thingspeak
MOwolawi Arduino uno Thingspeak | .. .27 . . .
. limited its potential for | for IoT data handling,
PMapayi TMalele off-grid applications
VAiyetoro GOjo J gric app ’
Project 4, 01 Arduino Ide N(;)vi';ail;:g'iiotilzr its Yes: Combined
October 2022. By | Arduino mega 2560 and ge o ’ ent in e fer | Arduino Mega's
Rami M, A Majid | and Esp8266 Thinespeak Sel’Il,Si tsive oF remo tegy computational power
H, Al-Fadhali N &P . with ESP8266's Wi-Fi
Project 5, 2022 by No: Did not employ Yes: Implemented
Alselek solar energy, which LoRaWAN for long-
. LoRaWan, .
MAlcaraz-Calero | Raspberry pi Grafana could have enhanced its | range IoT

JSegura-Garcia
JWang Q

operational flexibility in
remote setups.

communication and
Grafana
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Table 2.3Comparison In Advantages and Disadvantages

Previous Project Advantages Disadvantages

Project 1 - Wide area connectivity | - Low data speeds and
using GSM. higher latency compared to
- Energy-efficient with Wi-Fi.
6LoWPAN. - Limited scalability for

real-time apps.

Project 2 - Real-time data handling | - Relies on stable internet
with Firebase. connectivity.
- Easy mobile app - Limited offline operation
integration using MIT. capability.

Project 3 - Simple and cost- - Limited computational
effective. power.
- Supports basic IoT - Requires external Wi-Fi
applications. shield for connectivity.

Project 4 Increased computational | - Higher complexity in
power with Arduino programming and
Mega. Integration.
- Reliable data handling | - Limited portability
with ESP8266.

Project 5 - Long-range - Relatively high cost.
communication with - Higher power
LoRaWAN. consumption compared to
- Advanced data microcontrollers.
visualization with
Grafana.

To summarize, the exponential growth of the Internet of Things (IoT) presents both
opportunities and challenges, particularly in terms of power optimization. As the number of
IoT devices grows, ensuring efficient energy usage is critical for increasing device longevity
and achieving sustainability. The integration of renewable energy sources, such as solar
power, and advancements in battery technology are critical steps toward achieving this goal.

However, the complexities of scaling these solutions and ensuring seamless interoperability

across diverse devices highlight the need for ongoing innovation and research.
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Microcontrollers such as the ESP8266, ESP32, Raspberry Pi, Arduino Uno, STM32,
and ATtiny85 are central to IoT applications, providing the processing capacity and
connectivity required. These devices enable the creation of prototypes and finished products
capable of efficiently collecting, processing, and transmitting data. Their diverse features
and capabilities make them suitable for a wide range of applications, from basic control tasks
to advanced data analysis and communication, emphasizing their critical role in the IoT
ecosystem.

Moreover, combining solar energy with IoT technology provides an
environmentally friendly way to satisfy these systems' energy needs, especially in isolated
and off-grid locations. When paired with effective energy storage technologies, solar
photovoltaic systems guarantee a consistent power source and improve the general
performance of Internet of Things applications. In addition to promoting energy security and
environmental preservation, this interaction between renewable energy and the Internet of
Things also encourages the creation of robust, self-sufficient systems in a variety of
industries. Sustained progress in this field is crucial to propel innovation and attain enduring

expansion within the Internet of Things terrain.
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CHAPTER 3

METHODOLOGY

3.1 Introduction

This project focuses on developing a sustainable and efficient water filtration system
for fishponds by integrating solar energy and IoT-based monitoring technologies. The three
stages of the technique are as follows: first, a thorough literature review is conducted to
obtain information about current technologies involving fishpond water filtration systems,
Internet of Things-based monitoring, and solar energy integration. The following project
goals—building hardware components, establishing user-friendly software for system
control and optimization, and assessing system performance to guarantee efficient
operation—are informed by this fundamental research.

During the hardware setup phase, a solar-powered system that controls a 12V DC
pump for water filtration is designed using an ESP8266 microcontroller. A charge controller
allows batteries to hold the DC electricity produced by solar panels, providing a steady
power source even when there is not enough sunlight. In order to enable real-time monitoring
and control, the microcontroller exchanges data with a cloud service and processes data from
many sensors, including turbidity and TDS sensors. With this configuration, the system is
guaranteed to be both energy-efficient and able to be operated remotely via a mobile

application.
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MIT App Inventor and Google Firebase are used in the software setup phase to
generate a simple user interface and real-time data management system. The application
shows sensor data, allows user interaction with a simple drag-and-drop interface, and enables
remote monitoring and management of the water filtration system. Through the employment
of these tools, the project hopes to improve the system's accessibility and usability and enable
users to effectively monitor fishpond water quality from anywhere. To create a water
filtration system that is dependable and sustainable, this integrated method integrates

cutting-edge hardware and software technologies.
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3.2 IoT Project Development Flow

The process in Figure 3.1 is developing a solution using a microcontroller begins
with identifying a specific problem or challenge to address. Once the problem is clearly
understood, brainstorming ideas and potential solutions leads to creative concepts for
tackling the challenge. An algorithm is then developed, which serves as a step-by-step
procedure outlining how the microcontroller will achieve the desired outcome. To visualize
and refine this logic, a flowchart is created, using symbols like boxes, diamonds, and arrows
to represent the sequence of steps, decisions, and loops involved. With the logic clearly
mapped out, the next step is coding, where the algorithm and flowchart are translated into a
programming language suitable for the microcontroller, such as C or C++. This code dictates
the microcontroller's actions and is finally uploaded onto the device, enabling it to execute

the instructions and implement the solution effectively.

Protilem f—— Igea - e Algoritnm e Flow Chart . Coding p———p Microcontrolier

Figure 3.1 Flowchart of Development Flow Process
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3.3 Overal Project Methodology Flowchart

The project as in begins with a literature review to gather information and
understand existing technologies related to fishpond water filtration systems, IoT-based
monitoring, and solar energy integration. The objectives of the project are then outlined:
Objective 1 is to create the hardware components of the filtration system powered by solar
energy and including an IoT-based monitoring system. Objective 2 involves developing
software to control, optimize, and monitor the system, utilizing MIT App Inventor and
Firebase for user-friendly interface and real-time data management. Objective 3 focuses on
evaluating the system's performance to ensure it operates effectively and efficiently. This
structured approach aims to build a sustainable and effective water filtration system for

fishponds. Flowchart of Project methodology show as Figure 3.2.
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Figure 3.2 Flowchart of Project Methodology
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3.4 Phase 1 : Hardware Setup

Direct current (DC) power is generated by solar panels upon receiving sunlight, the
quantity of DC electricity generated is dependent upon the size, efficiency, and strength of
the solar panel. The charge controller receives this DC electricity and uses it to control the
electricity flow and prevent overcharging of the batteries. The charge controller lets the
battery bank get its maximum current flow. After that, it reduces the current, only a small
current keeps the battery fully charged. When the solar panels aren't producing energy, the
DC electricity is kept in the battery bank for later use. Batteries can be used directly to power

DC appliances. Figure 3.3 Power Generation and Storage Part.

Figure 3.3 Power Generation and Storage part
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This system shows the IoT system that runs on solar power and regulates a 12V DC
pump in a water filtration system. The power source for the system is solar-powered. The
core component of the system is an ESP8266 microcontroller, which processes information
from linked sensors to monitor water turbidity or other factors. To handle water filtration,
the microcontroller regulates a relay, an electrically powered switch, which in turn turns on
or off a 12V DC pump. Furthermore, the microcontroller establishes a Wi -Fi connection
with a cloud service, allowing for remote control and monitoring via a mobile application.
This configuration provides effective and responsive system performance by enabling users
to monitor and control the water filtration process in real-time from any place. Operational

Control Part show as in Figure 3.4.

Mobille App
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Supply t Microcontroiler Sensor
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Relay Module

> 12V DC Pump

Figure 3.4 Operational Control Part
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3.4.1 Experimental Equipmenet Setup

This water pump in Figure 3.5 works with a DC voltage between 6 and 12 volts and
uses 400 milliamps of current, giving it a power output of about 4 to 5 watts. It can pump up
to 500 liters of water per hour, which is great for keeping water moving steadily. These
features make the pump a good choice for small to medium-sized projects like water

filtration systems, and aquariums where a reliable flow of water is needed.

DC 6~12V 5W DC Female Port
*Can use with DC 12V 1A Adapter 5.5*2.5mm
*Can use with a suitable Solar Panel

Figure 3.5 DC water pump S00L/H

This solar panel in Figure 3.6, which is of the polycrystalline type and measures
145mm x 145mm x 3mm (thickness), outputs 12V at 250mA, providing a total power output
of 3W. It performs best when exposed to full sunlight, efficiently converting solar energy
into electrical power. With its compact size and decent power generation, this panel is ideal
for applications like small electronic devices, solar chargers, or low-power systems where

space and weight are significant factors.
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Sunlight

Solar Cells Element

Figure 3.6 Solar panel 3w

The relay module in Figure 3.7 being used has a maximum load capacity for the
normally open interface of AC 250V/10A and DC 30V/10A, with a trigger current of SmA.
It features a power indicator (green) and a relay status indicator (red). Connected to an
ESP8266, this relay module is used to control the activation of a 12V DC pump. The green
power indicator shows when the module is powered, while the red indicator changes based
on the relay's status, providing a visual cue for monitoring the pump's operation. This setup

allows for convenient and efficient control of the pump using the ESP8266 microcontroller.

3/

Figure 3.7 Relay module
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The Figure 3.8 show solar charge controller being used in this project has several
important functions to ensure efficient and safe operation. In addition to its adaptive voltage
of 12V and current handling capacity of 10A, it features an LCD display for easy monitoring
and control. The controller also includes a dual USB charging interface, allowing USB-
powered Esp8266 directly from the solar system. It provides power and voltage display
functionalities. Moreover, the controller manages the charging and discharging processes of
the connected lithium-ion battery, optimizing energy utilization and prolonging battery life.

When connected to a load which is dc pump.and energy powered by 3W solar panel.

Figure 3.8 Solar charge controller

The TDS value measures how many milligrams of dissolved solids are in one liter
of water. A higher TDS value usually indicates more dissolved solids, which can make the
water appear murkier or more turbid in a fishpond. Therefore, the TDS value is an important
indicator of water clarity or turbidity, commonly checked in fishponds. Gravity Analog TDS
Sensors, which are affordable consumer-grade devices widely available in the market, were
used for this project. Compared to an industrial-grade TDS sensor, the Gravity Analog TDS
sensor as in Figure 3.9is significantly more budget-friendly, making it a practical choice for

monitoring turbidity in fishponds.
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Figure 3.9 TDS Sensor module

The ESP8266 microcontroller as Figure 2.1 plays a key role in this setup, connecting
various components to streamline the fish pond system. It interfaces with the turbidity sensor
to monitor water quality, activating a relay to control the DC pump as needed for filtration.
Powered by solar energy, the ESP8266 ensures sustainable operation. Its Wi-Fi capability
enables real-time data transmission to a database, facilitating remote monitoring via a
dedicated mobile app. This integrated approach leverages technology to maintain water
clarity, automate pump operations, and provide accessible monitoring for efficient fish pond

management.
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Figure 3.10 Esp8266 module

For this project, sealed lead acid (SLA) battery have selected as Figure 3.11 with a
standard voltage of 12 volts and a capacity of 4500 milliampere-hours (mAh). This type of
battery is well-known for its reliability and durability, making it a suitable choice for various
applications. With a capacity of 4500mAbh, this battery can store a significant amount of
energy, providing ample power to sustain the project’s operations over extended periods.
Sealed lead acid batteries are also maintenance-free, meaning they do not require regular
topping up with water, unlike their traditional lead-acid counterparts. Furthermore, their
sealed design minimizes the risk of leaks and makes them safer to handle and use. This
makes the SLA battery a practical and efficient power source for projects that require stable

and long-lasting power.
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Figure 3.11 Sealed lead battery

3.4.2 Hardware procedure Functionality Checking

Table 3.1 Indicator in Hardware Part

Step | Hardware Part Indicator Functioned Indicator Failed

1 Esp8266 and Wi-fi | Connected / LED LED blinking with interval
blinking with interval 2 | 0.5 second
second

2 Solar Power Charge controllers No display on Charge
energize / Display Solar | controller
and Bulb

3 Input / Sensor Show reading / Blue Illogical / LED on module
Light LED on module on | off

4 Output / Actuator Pump on / sound of water | Pump off
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The process of checking in Table 3.1 and the functionality of hardware begins with
a systematic verification of all components and their interactions within the system. Step 1
is to power on the system, ensuring that all components receive the necessary voltage and
current. This includes observing initial LED indicators or displays to confirm that everything
is operating as expected. If any indicators fail to show, it is essential to check the power

supply and connections to the components.

Step 2 involves verifying the Wi-Fi and communication module, such as the
ESP8266, to ensure it functions correctly. This includes confirming that it connects to the
network and that the expected LED behavior, such as a solid or blinking light, is present,
indicating proper connectivity. Any issues with Wi-Fi connectivity may require checking

the network settings or hardware configuration.

Step 3 focuses on inspecting the solar power system, which includes the solar
panels, charge controllers, and connected devices. The charge controller's display or
indicators should reflect the correct operational status, ensuring that the system is properly
charging and regulating power. If the charge controller shows errors or no readings, further

inspection of the solar panel and wiring may be required.

Step 4 involves sensor input validation, where sensor modules are tested to ensure
they provide accurate readings on the system interface. The LED indicators on the sensors
should show proper functionality, signaling that the sensors are correctly measuring
parameters such as temperature, humidity, or water quality. If any sensor readings are out of

range or fail to show up, recalibration or hardware checks may be necessary.
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Step 5 ensures the proper functioning of output devices such as pumps or actuators.
These devices are activated to confirm that they perform their intended functions, with
operational sounds or visible activity serving as confirmation. If any output devices fail to

activate, a thorough check of wiring, power supply, and configuration is required.

Step 6, if errors or faults are detected, involves a systematic troubleshooting process.
This step includes checking connections, power supplies, and configurations to resolve any
issues. Once all faults are addressed, the components should be rechecked to confirm the

system is fully operational.

Finally, after resolving any issues, all components are re-evaluated to ensure the
system is stable and functioning correctly. Findings should be documented for future
reference and verification before deployment, ensuring a reliable and fully operational

system.
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3.5 Phase 2 : Software Setup

It is focuses on the integration and utilization of three key software tools—Arduino
IDE, Firebase Console, and MIT App Inventor—in the development of a robust and efficient
IoT-based system. Arduino IDE serves as the primary platform for programming and
deploying code to microcontrollers, ensuring seamless interaction with hardware
components. Firebase Console provides a cloud-based database solution for real-time data
storage, retrieval, and synchronization, enabling efficient communication between the
hardware and other devices. Meanwhile, MIT App Inventor is employed for the design and
development of a user-friendly mobile application, facilitating remote monitoring and
control of the system. Together, these software tools contribute to creating a cohesive and
functional system, demonstrating the power of combining programming, cloud technology,
and mobile interfaces in modern IoT applications. This report outlines their individual roles,

configurations, and the synergy they bring to the overall project workflow.

3.5.1 Arduino IDE

The Arduino Integrated Development Environment (IDE) in Figure 3.12 is a user-
friendly software platform used for writing, editing, and uploading code to microcontrollers
like Arduino boards and compatible devices such as the ESP8266. It provides a simple text
editor with features like syntax highlighting, code completion, and error checking, making
programming accessible to beginners. The IDE includes a built-in compiler that translates
code into machine-readable instructions and offers easy access to a vast library manager for
adding pre-written libraries for sensors and other hardware. It also features a Serial Monitor

for real-time debugging and monitoring of data from the microcontroller. Compatible with
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Windows, macOS, and Linux, the Arduino IDE is a powerful tool for developing a wide

range of embedded systems and IoT projects.

Ln 1, Col 1 NodeMCU 1.0

Figure 3.12 Arduino IDE Interface

The Arduino IDE is used to program and upload code to microcontrollers like the
ESP8266 or Arduino. To begin, download the IDE from the official Arduino website and
install it following the on-screen instructions. After installation, set up the IDE for your board
by navigating to File > Preferences and adding the ESP8266 board URL in the "Additional
Board Manager URLs" field. Then, open Tools > Board > Boards Manager to install the
necessary libraries for your specific board. Create a new sketch under File > New, write or
paste your code into the editor, and connect your microcontroller to the PC using a USB
cable. Configure the hardware by selecting the correct port under Tools > Port, then click
the upload button to compile and upload the code. Use the Serial Monitor to observe debug
messages and outputs. For best results, ensure you use appropriate libraries for sensors and

modules, and regularly test and debug your code to maintain functionality.
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3.5.2 Mit App Inventor

The application was created using MIT App Inventor from Massachusetts Institute
of Technology (MIT). It's designed to be user-friendly, featuring a straightforward interface
and seamless server-side connectivity. This software offers drag-and-drop functions that
assist designers in creating the user interface. MIT App Inventor includes bars with options
for buttons and designs. Its user interface consists of two main editors: the design editor for
arranging Ul elements using drag-and-drop, and the block editor for other functionalities.

Figure 3.13 Show designer block of MIT app Inventor.
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Figure 3.13 MIT App Inventor Website
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MIT App Inventor is a platform for designing and building mobile applications
using a user-friendly drag-and-drop interface. To get started, visit MIT App Inventor and
sign in with your Google account. Create a new project by clicking "Start New Project,"
entering a project name, and confirming. Design the app's user interface by dragging
components like buttons, labels, and text boxes from the Palette onto the Viewer,
customizing their appearance and behavior through the Properties tab. Switch to the Blocks
view to program the app’s functionality by using drag-and-drop blocks for tasks like reading
data from Firebase or triggering actions when buttons are clicked. To connect the app to
Firebase, add a Firebase Database component, then configure the Firebase URL and Token
in the Properties tab. Test the app in real-time on a mobile device using the AI Companion
App, making adjustments as needed. Finally, export the app as an APK file and install it on

your mobile device for use.
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3.5.3 Firebase Website

Using Google Firebase hostingas in Figure 3.14, we obtained an API code and
connected it to the application server for storage. The Firebase Real-time Database is a
cloud-based database that stores data in JSON format and keeps it updated in real-time across
all connected clients. Firebase provides storage space to save data from devices and display
it on the application. To access this space, we use an API key, which must be integrated into
the application's server-side to display the data on the app. Figure 3.14 show Firebase

console website.

Make your app ®© the best it can be
with Firebase and generative Al

Build & run modern, A
with Firet 3

Figure 3.14 Firebase console view

Firebase is a cloud-based platform used to create a real-time database for storing
and retrieving data. To begin, sign up and log into the Firebase Console using your Google
account. Create a new Firebase project by clicking "Add Project," entering a project name,
and enabling Google Analytics if needed. Next, navigate to the Build > Realtime Database
section, create the database, select a region, and choose either Locked Mode (default) or Test
Mode for initial testing. To configure Firebase for Arduino, generate a private key under
Project Settings > Service Accounts in the Firebase Console and include the credentials in
your Arduino sketch using Firebase libraries, such as Firebase ESP8266. Finally, monitor
and test real-time data updates through the Firebase Console, allowing you to write, read,

and update data directly from your hardware.
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3.5.4 Software procedure

The procedure in Table 3.2 is for software checking involves multiple stages to
ensure each component functions correctly. Step 1 focuses on verifying Arduino IDE
functionality. First, open the Arduino IDE and load the program onto the microcontroller
(e.g., ESP8266). Upload the program while monitoring the progress bar. If the upload
completes successfully, the program is functioning correctly. If errors occur, check for
compilation issues or upload failures. Open the Serial Monitor to verify that expected data,
such as sensor readings or system logs, is displayed. If no response or incorrect data is
shown, troubleshoot the code, hardware connections, or port settings to resolve the issue.

Step 2 involves verifying the Firebase Console functionality. Open the Firebase
Console and monitor the real-time database for updates from the hardware system. If the
database updates with the correct values in real-time, the system is functioning properly. If
no updates or incorrect data are recorded, check the communication between the hardware
and Firebase. If Firebase displays error messages, such as connection or authentication
issues, ensure the internet connection, authentication keys, and database rules are configured
correctly.

Step 3 focuses on testing MIT App Inventor functionality. Deploy the app created
in MIT App Inventor to a mobile device and check the user interface for responsiveness. If
the app updates data in real time and functions as expected, it is working correctly. If the app
crashes or displays incorrect data, further debugging is needed. Test all buttons and controls
in the app interface to ensure they respond promptly and perform their intended functions.
If buttons do not respond or show delayed actions, debug the app logic and verify proper

Firebase integration, then retest the app.
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Table 3.2 Indicator for Software Part

Software Indicator Indicator Failed What to be observe
Functioned
Arduino IDE Code compiles and Compilation errors | Progress bar during

uploads successfully.
Serial Monitor shows
expected output.

or upload failures.
Serial Monitor
displays unexpected
Or No response.

upload, Serial
Monitor outputs.
Watch for correct
sensor readings or
system status
messages.

Firebase Console

Real-time database
updates with correct
values.

No updates or
incorrect data in the
database.

Monitor data changes
visually on the
Firebase Console.

Communication Firebase error Observe connectivity

between hardware and | messages or and test database

Firebase works. connection issues. | rules/authentication
Mit App inventor | App interface is App crashes or Check for real-time

responsive and
updates correctly.
Buttons and controls
function as intended.

displays incorrect
data.

Buttons do not
respond or there’s a
delay.

data synchronization
in the app interface.
Test all interactive
elements manually
for proper behavior.
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3.5.5 Application Programme Flow

The system begins by searching for a Wi-Fi network, repeating the search if no
network is found. Once a network is detected, it checks for a successful connection. If
connected, the process proceeds to read data from the TDS sensor to measure the Total
Dissolved Solids (TDS) level. If the connection fails, the system will continue searching for
a network. The gathered sensor data, along with a timestamp, is then sent to Firebase for
storage and potential access by other devices or applications. The system then reads the
desired mode for the water pump from Firebase to check if the user has changed the operating
mode. If a mode change is detected, the system updates the pump operation accordingly. If
no change is needed, the system maintains the previous mode. Additionally, the ESP8266
retrieves the current time from a real-time clock (RTC) or an internet time server to ensure
accurate timestamps. The current status of the pump (on, off, or standby) is updated in
Firebase. The system continuously loops through these steps, monitoring the TDS sensor,
checking for mode changes, and updating both the pump status and sensor data in Firebase.

Figure 3.15 Sequent of Programme.
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3.5.6 Wifi Connection Login

The process in Figure 3.16 begins with the system searching for available Wi-Fi
networks in the vicinity. Once a network is found, the user is prompted to enter their
username and password for the selected Wi-Fi network. The system then attempts to connect
to the network using the provided credentials. If the login is successful, the process
continues; otherwise, it may display an error message or prompt the user to try again. Once
the Wi-Fi connection is established, the system proceeds to connect to Firebase, a cloud
database, and the associated mobile application. Finally, the process concludes, and the

system is ready for further interactions or data exchange.

Figure 3.16Wi-fi Login Flowchart
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3.5.7 Firebase Data Login

The process in Figure 3.17 begins by prompting the user to enter their username and
password. The system then verifies the provided credentials against stored information,
either in the ESP8266's memory or on a server. If the login is successful, the process
continues; otherwise, an error message is displayed or the user is asked to try again. Next,
the system checks if there is any pending data or configuration that needs updating on the
ESP8266 or in the mobile application. If an update is needed, the system reads the necessary
data from either the ESP8266 or the mobile application. Depending on the data transfer
direction, the system then writes the required information to the mobile app or the ESP8266.

Finally, the process concludes, and the system is ready for further interactions or commands.

Figure 3.17 Firebase Login Flowchart
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3.5.8 Switching Mode Option

The process in Figure 3.18 begins by checking if Mode 1 is selected. If Mode 1 is
chosen, the system operates in "Continuous" mode, where the system remains active
continuously. If Mode 1 is not selected, the system checks for Mode 2. If Mode 2 is selected,
the system operates in "Repeatedly on 1 Hour" mode, where the system activates every hour.
If Mode 2 is not selected, the system moves on to check for Mode 3. If Mode 3 is selected,
the system operates in "Based on TDS Read" mode, adjusting its operation based on readings
from a TDS sensor. If Mode 3 is not selected, the system checks for Mode 4. If Mode 4 is
selected, the system operates in "Optimize" mode, adjusting settings for optimal

performance. If none of the modes are selected, the system ends.
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Figure 3.18 Switching Mode Operation
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3.5.8.1 Mode 1 : Continuous Operation

The process in Figure 3.19 begins with the activation of the water pump, indicating
that it is turned on. Once the pump is activated, the system updates the relay status to the
associated mobile application, informing the user that the pump is running. The process
concludes at this point, with the system remaining in this state until further instructions or

commands are received.

v

1.1 Pump On

1.2 Update relay status to mobile app l

Figure 3.19 Mode 1 Operation Flow
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3.5.8.2 Mode 2 : Hourly Operation

The flowchart outlines in Figure 3.20 a control sequence for a water pump system
that operates based on whether the current hour is odd or even. The process begins by
checking if the system can obtain the current time. If successful, it proceeds to check if the
current hour is odd. If the hour is odd, the system turns the pump on and updates the status
to the associated mobile app. If the hour is even, the pump is turned off, and the status is
updated accordingly. After each action, the system updates the mobile app with the pump's
current status (on or off). The process concludes and waits for the next hour to check the

on/off condition again.

12.2.2 Update pump 1o mobile
1 anp

2.2 1 Pump off

2.4 Update relay status to
mobbe app

Figure 3.20 Mode 2 Operation Flow
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3.5.8.3 Mode 3 : TDS Based Operation

The flowchart outlines in Figure 3.21 the control logic for a water pump system that
operates based on readings from a TDS (Total Dissolved Solids) sensor and user input from
a mobile application. The process begins by ensuring the pump is initially turned off. The
system then enters a waiting state, monitoring for activation signals from the mobile app.
Once activated, the system reads the current TDS value from the connected sensor. The TDS
value is then compared to a pre-defined threshold, and if the condition is met (e.g., the TDS
value exceeds the limit), the system turns the pump on. If the condition is not met, the pump
remains off. After adjusting the pump's state, the system updates the mobile app with the
current pump status. At the end of the cycle, the pump is turned off, and the system

concludes, returning to the waiting state until the next activation signal.

34 Pump on Based on
tds valus Condition

|
¥

3 5 Pump Status updale to
mabile app

Figure 3.21 Mode 3 Operation Flow
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3.5.8.4 Mode 4 : Optimize Operation

The flowchart outlines in Figure 3.22 the control logic for a water pump system that
operates based on a combination of time-based scheduling and TDS (Total Dissolved Solids)
sensor readings. The process begins by checking the current time and comparing it to a pre-
defined schedule. If the current time matches the scheduled time, the system proceeds;
otherwise, it waits for the scheduled time to arrive. Once the scheduled time is reached, the
system reads the current TDS value from the connected sensor. The TDS value is then
analyzed and compared to a pre-defined threshold, and if the condition is met (e.g., the TDS
value exceeds the limit), the pump is turned on. If the condition is not met, the pump remains
off. After adjusting the pump's state, the system updates the mobile app with the current
pump status. At the end of the scheduled operation, the pump is turned off, and the process

concludes, waiting for the next scheduled time to repeat the cycle.
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Figure 3.22 Mode 4 Operation Flow
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3.6 Phase 3 : Experimental Data Analysis

In this phase, the focus is on the analysis of experimental data collected during the
system's testing and operation. The objective is to evaluate the performance, reliability, and
efficiency of the system under various conditions. By systematically examining the recorded
data, key insights into system behavior are obtained, which aid in identifying trends,
validating hypotheses, and addressing any anomalies. This analysis is essential for
understanding how well the system meets its design objectives and for proposing potential
improvements. The findings from this phase form the foundation for making data-driven

decisions to optimize the system further.

3.6.1 Solar Panel as a Source

The solar panel serves as the primary source of renewable energy, and its
performance data is collected to evaluate its efficiency and suitability for the system. A
multimeter is used for this purpose as in Figure 3.23, with voltage measurements taken by
connecting the multimeter in parallel with the panel's terminals and current measurements
taken by connecting it in series with the load. This data collection process provides valuable
insights into the solar panel's output under various conditions, aiding in performance analysis

and system optimization.
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Figure 3.23 Measuring Data in Solar Panel

3.6.2 TDS Sensor for Quality of Water

The TDS (Total Dissolved Solids) sensor as in Figure 3.24 is used to measure the
quality of water by detecting the concentration of dissolved solids, providing real-time data
on water purity. This data is crucial for assessing the effectiveness of the tank and filtration
system in maintaining clean water. The sensor operates through four different modes,
allowing the system to adjust its behavior based on specific water quality parameters, such
as continuous monitoring, hourly checks, optimized control, and TDS-based decision-
making. Data is collected over a period of three days, allowing for a detailed analysis of how
the water quality varies over time and under different operational conditions. The tank serves
as a storage reservoir, where water is stored after filtration, while the filter works to remove
impurities and contaminants. By combining the TDS sensor's data with the filtration system's
performance, the system ensures that the water remains clean and meets the required quality
standards throughout the entire process. This extended data collection period enhances the
accuracy of the analysis, providing valuable insights for system optimization and

maintenance.
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Figure 3.24 TDS sensor Arrangement in Hardware

3.6.3 Analysist in Battery Percentages

To calculate the battery percentage over time based on the pump's power
consumption, we start by determining the energy consumption rate and the battery's total
capacity. The pump's power consumption is given in watts (e.g., SW), and the battery's
capacity is measured in watt-hours (Wh), which is calculated as the product of the battery's
voltage (V) and ampere-hour (Ah) rating. For example, a 12V, 4.5Ah battery has a total
capacity of 54 Wh. The percentage of battery consumed per hour is calculated by dividing
the pump's hourly power consumption 5 Wh by the battery's total capacity 54 Wh and
multiplying by 100, which gives approximately 9.26% of battery usage per hour. Starting
with a full battery (100%), the battery percentage decreases by 9.26% each hour the pump
operates. This formula is applied iteratively for each hour, subtracting 9.26% from the
previous percentage, until the battery reaches 0%, indicating complete depletion. This
method provides a straightforward way to predict the battery life for a specific device based

on its power usage.
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Batery Percentages

Power Consumption Per Hour
Battery Capacity

= Previous Battery Percentages — ( X 100)

Battery Capacity (Wh) = Battery Voltage (V) X Battery Capacity (Ah)
Battery capacity = 12V x4.5Ah =54Wh

Power consumption per hour = 5Wh

5
Battery Usage Per Hour (%) = <z X 100 = 9.26%

3.7 Summary

In conclusion, this project integrates innovative solar energy and Internet of Things
(IoT)-based monitoring technologies to create a sustainable and effective water filtration
system designed for fishponds. The process was divided into three separate phases. The first
phase involved a thorough analysis of the literature to extract useful information from current
technologies related to solar energy integration, loT-based monitoring, and fishpond water
filtration systems. The project's primary goals were defined and accomplished with the help
of this foundational research, which included the development of durable hardware
components, the creation of user-friendly software for smooth system control and
optimization, and the careful assessment of system performance to guarantee optimal

functionality.
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This device used an ESP8266 microprocessor to run a 12V DC pump that was
important to the filtering of the water. Using solar panels to generate DC electricity and
charging batteries with the help of a charge controller allowed for a reliable power source to
be maintained even though there was no of direct sunlight. The microcontroller was essential
to the data processing process because it interfaced with a variety of sensors, such as TDS
and turbidity sensors, and it easily connected with a cloud service to enable real-time control
and monitoring. In addition to highlighting the system's energy efficiency, this
comprehensive configuration enabled remote operational capabilities via the user-friendly
mobile application interface.

The software development phase was equally impactful, utilizing the capabilities of
MIT App Inventor and Google Firebase to create a friendly and packed with capabilities user
experience combined with a powerful real-time data management system. This dynamic
application not only enabled remote monitoring and management of the water filtration
system, but it also offered users with extensive insights by visualizing sensor data. The
application's interactive nature, defined by its simplified simply drop interface, exemplified
usability and accessibility, allowing users to efficiently regulate water quality in fishponds
from any location. This combination of advanced hardware and software solutions represents
a paradigm leap toward a dependable, sustainable, and technologically advanced water

filtration system designed specifically for modern aquaculture techniques.
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CHAPTER 4

RESULTS AND DISCUSSION

4.1 Introduction

This chapter presents the project's primary outcomes, with the focus on integrating
the ESP8266 microcontroller with Firebase utilizing MIT App Inventor and IoT principles.
The project is a hands-on exploration of real-world Internet of Things (IoT) applications,
taking advantage of the ESP8266's capabilities, Firebase cloud services, and the user-
friendly MIT App Inventor interface.

The successful configuration of the ESP8266 with Wi-Fi connectivity is required
for stable functioning. Communication with web servers, cloud services, and other internet-
connected devices is enabled by programming the microcontroller to connect to available
networks and authenticate with the relevant keys. The addition of a DHT11 sensor for
temperature and humidity readings improves its functionality by permitting real-time data
transmission to Firebase for remote access and monitoring. Additionally, a Proteus
simulation shows a water filtration system managed by the ESP8266, demonstrating its
automated control and real-time monitoring capabilities.

The project also involves a water quality testing with Total Dissolved Solids (TDS)
and turbidity measurements. These data aid in classifying water clarity and particle
concentration levels, which are critical for assessing filtration performance. The results
reveal distinct levels of water clarity and turbidity, demonstrating that the filtration system

is effective in maintaining water quality.
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4.2 Phase 1 : Result for Hardware Operation

This phase focuses on evaluating the operational performance of the hardware
components within the system. The primary objective is to ensure that each hardware module
functions as intended and integrates seamlessly into the overall setup. Testing procedures
are conducted under various conditions to verify the reliability, stability, and efficiency of
the hardware. The results from these evaluations provide critical insights into the system's
physical performance, highlighting any areas that require optimization or adjustment. This

phase lays the groundwork for the subsequent integration and functionality of the system.

4.2.1 TDS water Level Condition

Water TDS can be sorted into five levels. Clear water means the water is super clear,
showing very high quality with hardly any dissolved solids. Slightly TDS water has a bit of
a haze but is still pretty cl<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>